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Updated may 2020
QUESTION 1

Which two extended capabilities must be configured
on dial peers for fast start-to-early media scenarios
(H.323 to SIP interworking)? (Choose two.)



A. DTMF

B. BFCP

C. VIDEO

D. FAX

E. AUDIO



Correct Answer: AB

QUESTION 2

When you troubleshoot H.323 call setup, which
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message informs you that the called party is being
notified about the call?



A. ALERTING

B. PROCEEDING

C. CONNECT

D. RINGING



Correct Answer: C

QUESTION 3

End users at a new site report being unable to hear
the remote party when calling or being called by
users at headquarters. Calls to and from the PSTN
work as expected. To investigate the SIP signaling to
troubleshoot the problem, which field can provide a
hint for troubleshooting?



A. Contact: header of the 200 OK response

B. Allow: header if the 200 OK response

C. o= line of SDP content

D. c= line of SDP content



Correct Answer: C

QUESTION 4

Why would RTP traffic that is sent from the
originating endpoint fail to be received on the far
endpoint?

A. The far end connection data (c=) in the SDP was
overwritten by deep packet inspection in the call signaling
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path.

B. Cisco Unified Communications Manager invoked
media termination point resources.

C. The RTP traffic is arriving beyond the jitter buffer on
the receiving end.

D. A firewall in the media path is blocking TCP ports
16384-32768.



Correct Answer: D

QUESTION 5 An administrator is troubleshooting call
failures on an H.323 gateway via the CLI. To see
signaling for media and call setup, which debug must
the Administrator turn on?



A. debug H.323 messages

B. debug H.225 asn1

C. debug H.246 asn 1

D. debug H.225 media

E. debug H.323 asn 1



Correct Answer: B

QUESTION 6 What is first preference condition
matched in a SIP-enabled

incoming dial peer?



A. incoming uri

B. target carrier-id

C. answer-address

D. incoming called-number




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Correct Answer: A

QUESTION 7

Cisco SIP IP telephony is implemented on two floors
of your company. Afterward, users report intermittent
voice issues in calls established between floors. All
calls are established, and sometimes they work well,
but sometimes there is oneway audio or no audio.
You determine that there is a firewall between the
floors, and the administrator reports that it is
allowing SIP signaling and UDP ports from 20000 to
22000 bidirectionally. What are the two possible
solutions? (Choose two.)



A. Go to the SIP profile assigned to these IP phones in
Cisco Unified CM and change the range of media ports to
16384-32767

B. Ask the firewall administrator to change the ports to
TCP.

C. Ask the firewall administrator to change the range of
UDP ports to 16384-32767.

D. Go to the SIP profile assigned to these IP phones in
Cisco Unified CM and change the range of media ports to
20000-22000.

E. Go to System Parameters in Cisco Unified
Communications Manager and change the range of
media ports to 20000-22000.



Correct Answer: AC
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QUESTION 8

Which section under the Real-Time Monitoring Tool
allows for reviewing the call flow and signaling for a
SIP call in real-time?



A. Analysis Manager > Inventory > Trace File
Repositories

B. System > Tools > Trace and Log Central

C. Voice/Video > Session Trace Log View > Real Time
Data

D. Voice/Video > Session Trace Log View > Open From
Local Disk



Correct Answer: C

QUESTION 9 Which description of RTP timestamps
or sequence

numbers is true?



A. The sequence number is used to detect losses.

B. Timestamps increase by the time “carrying” by a
packet.

C. Sequence numbers increase by four for each RTP
packet transmitted.

D. The timestamp is used to place the incoming audio
and video packets in the correct timing order (playout
delay compensation).



Correct Answer: D
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Site Navigation

QUESTION 10 A support engineer is troubleshooting
a voice network. When conducting a search for call
setup details related to calling search space issues,
which trace files should be investigated?



A. CallManager traces

B. CTI Manager traces

C. Cisco IP Manager Assistant

D. Call logs



Correct Answer: A

QUESTION 11

A company has an SRST gateway running an IOS XE
image. The company plans to enable the IPv6
addressing companywide. To enable the IPv6 in a
unified SRST gateway to support SIP phones, what
are two supported supplementary features for an
IPv6 fallback scenario? (Choose two.)



A. three-way conference

B. secure SIP lines

C. T.38 fax relay

D. transcoding

E. SIP trunk



Correct Answer: AC

QUESTION 12

You see the voice register pool 1 command in your
Cisco Unified Communications Manager Express
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configuration. Which configuration is occurring in
this section?



A. configuration for a single SIP phone

B. configuration items common for all SIP phones

C. configuration for a pool of SIP phones (similar to
devise pool on Cisco Unified Communications
Manager)D. configuration for SIP registrar service



Correct Answer: C

QUESTION 13

Which top-level IOS command is needed to begin the
configuration of a Cisco Unified Communications
Manager Express gateway to enable phones to be
registered via SIP?



A. allow-connections sip to sip

B. voice service voip

C. voice register global

D. voice register dn



Correct Answer: C

QUESTION 14 For s SIP to SIP call flow, when does
Cisco Unified Border Element require transcoding

resources for DTMF?



A. interworking between an OOB method and RFC2833
for flow-around calls

B. interworking between h245-signal and rtp-nte
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C. interworking between an OOB method and RFC2833
for flow-through calls

D. interworking between h245-alpha numeric and sip-
kpml



Correct Answer: A

QUESTION 15 Which IOS command creates a
SIPenabled

dial-peer?



A. voice dial-peer 20 sip

B. dial-peer voice 20 voip

C. dial-peer voice 20 pots

D. dial peer voice 20 sip



Correct Answer: B

QUESTION 16

A user in location X dials an extension at location Y.
The call travels through a QoS-enabled WAN network,
but the user experiences choppy or clipped audio.
What is the cause of this issue?



A. missing Call Admission Control

B. codec mismatch

C. ptime mismatch

D. phone class of service issue



Correct Answer: B
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QUESTION 17

An engineer must route all SIP calls in the form of
@example.com to the SIP trunk gateway corporate
local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)



A. example.com@gateway.corporate.local

B. *@example.com

C. gateway.corporate.local

D. example.com

E. *.*



Correct Answer: BE

QUESTION 18

Which two statements are correct with respect to the
Client Matter Code setting in the route pattern
configuration? (Choose two.)



A. The Client Matter Code feature does not support
overlap sending because the Cisco Unified CM cannot
determine when to prompt the user for the code.

B. If you check the Allow Overlap Sending check box, the
Require Client Matter Code check box becomes disabled.

C. If you check the Allow Overlap Sending check box,
you can also check the Require Client Matter Code check
box.

D. The Client Matter Code feature does support overlap
sending because the Cisco Unified Communications
Manager can determine when to prompt the user for the
code.

E. The Client Matter Code has the option to configure
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Authorization Level such as in the Forced Authorization
Code.

Correct Answer: AB

QUESTION 19 A network engineer designs a new dial
plan and wants to block a certain range of numbers
(8135100 through 8135105). What is the most specific
route pattern that can be configured to block only the

numbers in this range?



A. 813510[012345]

B. 813510[12345]

C. 813510[^0-5]

D. 81XXXXX



Correct Answer: A

QUESTION 20 Which two descriptions of the
Standard Local Route Group deployment are true?
(Choose two.)



A. can be associated under the route group

B. can be associated only under the route list

C. chooses the route group that is configured under the
device pool of the calling-party device

D. chooses the route group that is configured under the
device pool of the called-party devices. can be assigned
directly to the route pattern



Correct Answer: BD
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QUESTION 21 After configuring a Cisco CallManager
Express with Cisco Unity Express, inbound calls
from the PSTN SIP trunk receive a ring tone for 20
seconds and then a busy signal instead of voicemail.
Which configuration fixes this problem?



A. Router(config)# voice service VoIP

Router(conf-voi-serv)#allow-connections h323 to h323

B. Router(config)#dial-peer voice 2 voip

Router(config-dial-peer)#no vad

C. Router(config)# voice service voip
Router(conf-voi-serv)#allow-connections voice-mail mod

D. Router(config)# voice service voip
Router(conf-voi-serv)#no supplementary-service sip
moved-temporarily



Correct Answer: A

QUESTION 22 An engineer must configure a secure
SIP trunk with a remote provider, with a specific
requirement to use port 5065 for inbound and
outbound traffic. Which two items must be
configured to complete this configuration? (Choose
two.)



A. Incoming Port in SIP Information section of the SIP
Trunk configuration.

B. Incoming Port in Security Information of the SIP Profile
configuration.

C. Destination Port in the SIP Information section of the
SIP Trunk configuration

D. Incoming Port in SIP Trunk Security Profile
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Correct Answer: CD

QUESTION 23 In Cisco Unified Communications
Manager, which tool do you use to check SIP traces?



A. MTP

B. CCSIP

C. RTMT

D. OS Administration Page



Correct Answer: C

QUESTION 24 If all patterns below are configured in
Cisco Unified Communications Manager which would
be used when dialing the

pattern “123”?



A. 12!

B. 12X (urgent priority set)

C. 1XX (urgent Priority Set)

D. 12[2-5]



Correct Answer: B

QUESTION 25 Which configuration must an
administrator perform to display Translation Pattern
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operations in Cisco Unified Communications
Manager SDL traces?



A. Enable the Detailed Call Analysis option under
Enterprise Parameters for Unified CM.

B. Set up the Digit Analysis Complexity in Service
Parameters for Cisco Unified CM to
TranslationAndAlternatePatternAnalysis.

C. Check the Translation Patterns Analysis checkbox in
Micro Traces on the Cisco Unified CM Serviceability
page.

D. By default, the Translation Pattern operations are
printed in SDL traces, so no additional configuration is
necessary.



Correct Answer: A

QUESTION 26

The Cisco Unified Communications Manager Dialed
Number Analyzer allows analysis of calls from which
two devices? (Choose two.)



A. translation patterns

B. device pools

C. CTI ports

D. CTI route points

E. IP phones



Correct Answer: CE
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QUESTION 27 In Cisco Unified Communications
Manager globalized call routing is implemented and
must confirm that it is correctly implemented without
making a call. Which tool do you use for verification?



A. Dialed Number Analyzer

B. Real-Time Monitoring Tool

C. SDI trace

D. SDL trace



Correct Answer: A

QUESTION 28 How does an engineer globalize
routing for ingress calls coming from the PSTN to
internal DNs?



A. At the PSTN gateway, put the calling number in PSTN
format and the called number in DN format.

B. At Cisco Unified CM, put the calling number in E.164
format and the called number in PSTN format.

C. At the PSTN gateway, put the calling number in E.164
format and the called number in localized (DN) format.

D. At Cisco Unified Communications Manager, put the
calling number in E.164 format and the called number in
E.164 format.



Correct Answer: B

QUESTION 29 Which two types of distribution
algorithm are within a line
group? (Choose two.)
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A. random

B. circular

C. highest preference

D. top down

E. bottom up



Correct Answer: BD

QUESTION 30

An engineer is configuring a call park feature in
Cisco Unified Communications Manager Express.
Which command does the engineer use to ensure
that the call is reverted to the user after 60 seconds?



A. R2(config-ephone-dn)#park reservation-group 60

B. R2(config-ephone-dn)#park-slot timeout 60 limit 2
recall alternate 3002

C. R2(config-ephone-dn)#park reservation-group 1

D. R2(config-ephone-dn)#park-slot timeout 30 limit 2
recall alternate 3002



Correct Answer: B

QUESTION 31 When locations-based Call Admission
Control denies the call, which two masks can AAR
apply when routing the call through the

PSTN? (Choose two.)



A. AAR destination mask
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Data
science

B. called party transform mask

C. external phone number mask

D. +E.164 alternate number mask

E. enterrise alternate number mask



Correct Answer: AC

QUESTION 32

An administrator is configuring a cluster for ILS and
wants to limit the number of entities that Cisco
Unified Communications Manager can write to the
database for data that is learned through ILS. Which
service parameter is used to adjust this limit?



A. ILS Max Number of Learned Objects in Database

B. ILS Active Learned Object Upper Limit

C. Global Data Service Parameter Limit

D. Imported Dial Plan Replication Database Object Lower
Limit



Correct Answer: A

QUESTION 33

When configuring hunt groups, where do you add the
individual directory numbers that will be part of the
group?



A. route group

B. line group

C. hunt list

D. hunt pilot
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Correct Answer: B

QUESTION 34

Which configuration element of a hunt group allows
for changing Calling Party Transformations settings?



A. line group

B. hunt pilot

C. route group

D. hunt list



Correct Answer: B

QUESTION 35

Which two types of authentication are supported for
the configuration of Intercluster Lookup Service?
(Choose two.)



A. TokenID

B. username and secret key

C. TLS certificates

D. passwords

E. FQDN of the servers defined in DNS



Correct Answer: CD

QUESTION 36

Which two configuration parameters are
prerequisites to set Native Call Queuing on Cisco
Unified Communications Manager? (Choose two.)
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A. Cisco IP Voice Media Streaming Service must be
activated on at least one node in the cluster.

B. Unicast music on hold audio source must be
configured.

C. Cisco RIS data collector service must be running on
the same server as the Cisco CallManager service.

D. The maximum number of callers allowed in the queue
must be 10.

E. The phone button template must have the Queue
Status Softkey configured.



Correct Answer: AC

QUESTION 37

What is the relationship between partition, time
schedule, and time period in Time-of-Day routing in
Cisco Unified Communications Manager?



A. A partition can have multiple time schedules assigned.
A time schedule contains one or more time periods.

B. A partition can have one time schedule assigned. A
time schedule contains one or more time periods.

C. A partition can have multiple time schedules assigned.
A time schedule contains only one time period.

D. A partition can have one time schedule assigned. A
time schedule contains only one time period.



Correct Answer: A

QUESTION 38

Configure Call Queuing in Cisco Unified
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Communications Manager. Where do you set the
maximum number of callers in the queue?



A. in the telephony service configuration

B. in the queuing configuration

C. in Cisco Unified CM Enterprise Parameters

D. in Cisco Unified CM Service Parameters

Correct Answer: B

QUESTION 39

A user reports that when they attempt to log out from
the Cisco Extension Mobility service by pressing the
Services button, they cannot log out. What is the
most likely cause of this issue?



A. The Cisco Extension Mobility service has not been
configured on the phone.

B. There might be a significant delay between the button
being pressed and the Cisco Extension Mobility service
recognizing it. It would be best to check network latency.

C. The user device profile has not been assigned to the
user.

D. The user device profile is not subscribed to the Cisco
Extension Mobility service.



Correct Answer: D

QUESTION 40 What is a component of Cisco Unified
Mobility?



A. Unified IVR
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B. Mobile Connect

C. Smart Client Support

D. Single Number Connect



Correct Answer: B

QUESTION 41 When the services key is pressed
Cisco Extension Mobility does not show up. What is
the cause of the issue?



A. The URL configured for Cisco Extension Mobility is not
correct.

B. Cisco Extension Mobility Service is not running.
C. The phone is not subscribed to Cisco Extension
Mobility Service.

D. Cisco Extension Mobility is not enabled in the Phone
Configuration Window (Device > Phone)



Correct Answer: C

QUESTION 42 What are the elements for Device
Mobility

configuration?



A. physical location, device pool, and Device Mobility
group

B. device pool, Device Mobility group, and region

C. physical location. Device Mobility group, and region

D. device pool, Device Mobility group, and Cisco IP
phone
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Correct Answer: A

QUESTION 43

Which services are needed to successfully
implement Cisco Extension Mobility in a standalone
Cisco Unified Communications Manager server?



A. Cisco Extended Functions, Cisco Extension Mobility,
and Cisco AXL Web Service

B. Cisco CallManager, Cisco TFTP, and Cisco
CallManager SNMP Service

C. Cisco CallManager, Cisco TFTP, and Cisco Extension
Mobility

D. Cisco TAPS Service, Cisco TFTP, and Cisco Extension
Mobility



Correct Answer: C
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